RefWorks Accessibility Conformance Report

International Edition

(Based on VPAT® Version 2.5)

Name of Product/Version:

RefWorks, release October 15, 2025

Report Date:

October 2025

Product Description:

RefWorks is a web-based reference management tool that allows you to manage your references when writing or collaborating with other researchers. You can use
RefWorks to organize, store and share your references, and to instantly create citations and bibliographies.

Contact Information:

refworks.support@progquest.com or support@refworks.com

Notes:

Evaluation Methods Used:

“Voluntary Product Accessibility Template” and “VPAT” are registered
service marks of the Information Technology Industry Council (ITI) Page 1 of 47



e Deque’s Color Contrast Analyzer

e Deque’s axe DevTools accessibility testing tool

e High Contrast Chrome extension

e Chrome Developer Tools

o Keyboard-access manual testing and assessment

e Narrator and Voiceover screen readers

Applicable Standards/Guidelines

This report covers the degree of conformance for the following accessibility standard/guidelines:

Web Content Accessibility Guidelines 2.0 Level A (Yes)
Level AA (Yes)
Level AAA (No)
Web Content Accessibility Guidelines 2.1 Level A (Yes)
Level AA (Yes)
Level AAA (No)
Web Content Accessibility Guidelines 2.2 Level A (Yes)
Level AA (Yes)
Level AAA (No)
Revised Section 508 standards published January 18, 2017 and corrected January 22, 2018 (Yes)

EN 301 549 Accessibility requirements for ICT products and services - V3.1.1 (2019-11) AND
EN 301 549 Accessibility requirements for ICT products and services - V3.2.1 (2021-03)

(Yes)

Terms

The terms used in the Conformance Level information are defined as follows:
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e Supports: The functionality of the product has at least one method that meets the criterion without known defects or meets the criterion
with equivalent facilitation.

Partially Supports: Some functionality of the product does not meet the criterion.

Does Not Support: The majority of product functionality does not meet the criterion.

Not Applicable (N/A): The criterion is not relevant to the product.

Not Evaluated: The product has not been evaluated against the criterion. This can only be used in WCAG Level AAA criteria.

WCAG 2.X Report

Tables 1 and 2 also document conformance with:

e EN 301 549: Chapter 9 - Web, Sections 10.1-10.4 of Chapter 10 - Non-Web documents, and Sections 11.1-11.4 and 11.8.2 of Chapter 11
- Non-Web Software (open and closed functionality), and Sections 12.1.2 and 12.2.4 of Chapter 12 — Documentation

¢ Revised Section 508: Chapter 5 — 501.1 Scope, 504.2 Content Creation or Editing, and Chapter 6 — 602.3 Electronic Support
Documentation.

Note: When reporting on conformance with the WCAG 2.X Success Criteria, they are scoped for full pages, complete processes, and
accessibility-supported ways of using technology as documented in the WCAG 2.2 Conformance Requirements.

Table 1: Success Criteria, Level A

Notes:
Criteria Conformance Level Remarks and Explanations
1.1.1 Non-text Content (Level A) Partially Supports RefWorks is designed to support alternative access to non-

Also applies to:
EN 301 549 Criteria
e 9.1.1.1(Web)

text content wherever possible:
e Images used to represent functionality, or actions
have associated text labels or alt/title text.

e 10.1.1.1 (Non-web document) . .
e 11.1.1.1.1 (Open Functionality Software) e Text Ia.bels and/or ARIA labels are used to identify
e 11.1.1.1.2 (Closed Functionality Software) form fields
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e 11.8.2 (Authoring Tool) e reCAPTCHA verification provides an audible option

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)

Exceptions:

RefWorks
e The following are icons/images not hidden from

screen readers
o Sharing settings icons in the side navigation

Preview pane edit icon image

Citation view > missing data tags

YouTube icon in public URL

Export references icon in public URL

Create duplicate - Close button reads

"image" to screen readers

o Manage projects > Header > YouTube
button - Reads "image" to screen readers

o Manage projects > Share projects modal -
Accordion carat icon read as "J" to screen
reader

o Manage projects > Current project info
button - Image purpose not read to screen
reader

o RefWorks > Share project modal >
Remove button - Icon not hidden from
screen readers

O O O O O

Conformance determined with Narrator, VoiceOver and
manual visual checks.

1.2.1 Audio-only and Video-only (Prerecorded) (Level A) Supports RefWorks has training videos hosted on YouTube.
Also applies to:
EN 301 549 Criteria
e 9.1.2.1(Web)
e 10.1.2.1 (Non-web document)
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11.1.2.1.1 (Open Functionality Software)
11.1.2.1.2.1 and 11.1.2.1.2.2 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.2.2 Captions (Prerecorded) (Level A) Supports RefWorks has training videos hosted on YouTube.
Also applies to:
EN 301 549 Criteria
9.1.2.2 (Web)
10.1.2.2 (Non-web document)
11.1.2.2 (Open Functionality Software)
11.1.2.2 (Closed Software)
11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.2.3 Audio Description or Media Alternative (Prerecorded) (Level A) Supports RefWorks has training videos hosted on YouTube.
Also applies to:
EN 301 549 Criteria
e 9.1.2.3(Web)
10.1.2.3 (Non-web document)
11.1.2.3.1 (Open Functionality Software)
11.1.2.3.2 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
12.2.4 (Support Docs)
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Criteria

Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.3.1 Info and Relationships (Level A)
Also applies to:
EN 301 549 Criteria
e 9.1.3.1(Web)
e 10.1.3.1 (Non-web document)
e 11.1.3.1.1 (Open Functionality Software)
11.1.3.1.2 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

Conformance Level

Partially Supports
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Remarks and Explanations

The following are employed to support this criterion:

CSS is used to control the visual presentation of text
Labels are programmatically associated with form
input elements

HTML markup is used for headings and lists

Exceptions:
RefWorks

Manage Projects — Content visually appears to be a
data table but is not marked up as one

List tags <li> are not properly implemented or not
used semantically

Required ARIA child role missing from custom
combo boxes

Many form controls are missing labels or not
programmatically associated with a label
Unrelated radio buttons and checkboxes are
enclosed in a fieldset

Related radio buttons are not enclosed in a fieldset
Manage folders Table row checkboxes - Folder not
programmatically associated with checkbox
Create duplicate > Ref type dropdown - Dropdown
not associated with ref type label

Create duplicate > Electronic source checkbox -
"Electronic source" label not associated with
checkbox and description starts with "A select
checkbox..."

Manage projects > Current project info button -
Does not read info from info icon



e Manage projects > Share projects modal -
Label and description not associated with input box

e Preview citation > In-text and footnote radio
buttons — No programmatic way to tell inputs are
related

e Form controls missing labels or not
programmatically associated with a label

Save to RefWorks
e Assign to folders dropdown
o Dropdown label is not programmatically
associated with the dropdown menu
o Checkboxes are not programmatically
associated with folder names

Conformance determined with WAVE, Narrator, VoiceOver,
Chrome developer tools, and manual visual checks.

1.3.2 Meaningful Sequence (Level A)

Also applies to:

EN 301 549 Criteria
e 9.1.3.2(Web)
e 10.1.3.2 (Non-web document)
e 11.1.3.2.1 (Open Functionality Software)
e 11.1.3.2.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)

Partially Supports

The reading and navigation order (determined by code
order) is logical and intuitive. While the reading order and
visual order may not always match, the meaning is
unchanged.

Exceptions:
RefWorks
e Manage Projects — The reading order of the layout
table does not make sense when linearized
e Edit reference > Title and DOI search — Search
results are placed above the search field in the
DOM, making it cumbersome for users to navigate
toit
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e 602.3 (Support Docs) e PDF Reader — Screen readers cannot read PDFs
displayed in the RefWorks PDF reader. As an
alternative, click on the print icon in the PDF toolbar
to launch the browser's PDF viewer, which will
allow accessible PDFs to be read by a screen reader.

RCM (Windows)
e Modals
o Screen readers can read content outside
the modal dialog.
o When a modal dialog is activated, screen
reader focus is not always placed on/in it
e (Citation style, Project, and Language dropdown
menus — After selecting a menu item, keyboard
focus is not returned to the triggering element or
the next element in the tab order.

Conformance determined with Narrator, VoiceOver and
manual keyboard checks.

1.3.3 Sensory Characteristics (Level A) Supports Color and iconography are used to provide additional

Also applies to: semantic information about status messages and system
EN 301 549 Criteria state.

e 9.1.3.3(Web)

e 10.1.3.3 (Non-web document) Conformance determined with manual visual checks.

e 11.1.3.3 (Open Functionality Software)

e 11.1.3.3 (Closed Software)

e 11.8.2 (Authoring Tool)

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)
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1.4.1 Use of Color (Level A) Supports Color and iconography are used to provide additional

Also applies to: semantic information about status messages and system
EN 301 549 Criteria state.

e 9.1.4.1(Web)

e 10.1.4.1 (Non-web document) Conformance determined with Deque’s Color Contrast

e 11.1.4.1 (Open Functionality Software) Analyzer.

e 11.1.4.1 (Closed Software)

e 11.8.2 (Authoring Tool)

12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.4.2 Audio Control (Level A) Supports RefWorks has training videos hosted on YouTube.
Also applies to:
EN 301 549 Criteria
e 9.1.4.2 (Web)
e 10.1.4.2 (Non-web document)
e 11.1.4.2 (Open Functionality Software)
11.1.4.2 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

2.1.1 Keyboard (Level A) Partially Supports Functionality is accessible with keyboard only navigation.
Also applies to: .
EN 301 549 Criteria Exceptions: . .
e 9.2.1.1 (Web) e The following elements are not accessible through

keyboard navigation

e 10.2.1.1 (Non-web document)
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11.2.1.1.1 (Open Functionality Software)
11.2.1.1.2 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

o Sharing settings > levels: Can read, Can
annotate, Can modify combobox

o Import references from other file types >
Import from Mendeley > "Select the desired
project” link

o Import references from other file types >
Import from file > Import references modal

o Create bibliography > Back to all references
button

o Create bibliography > Differentiate authors
with the same name by surname link

o Citation view > missing data tags don’t open
on enter

o Tools > Extensions & Add-ons > Install Save
to RefWorks modal > Customize StR
bookmark button - Not in the keyboard tab
order

o Create duplicate > Find ref info lightning
bolt - Overlay is not keyboard accessible

o Manage projects page > Header >
institutional link - Not in tab order

e 3™ party provider, OneTrust has elements that are
not accessible through a keyboard

Conformance determined with Narrator, VoiceOver and
manual keyboard checks.

2.1.2 No Keyboard Trap (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.1.2 (Web)
e 10.2.1.2 (Non-web document)

Partially Supports

Once focus has been moved to a component with keyboard
only navigation, it can be moved away from that
component with keyboard only navigation.

Page 10 of 47




11.2.1.2 (Open Functionality Software)
11.2.1.2 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

Exceptions:
e (Create an account workflow
o “Resend activation link” and “start over”
links under activate your account cannot be
accessed by keyboard

Conformance determined with Narrator, VoiceOver and
manual keyboard checks.

2.1.4 Character Key Shortcuts (Level A 2.1 and 2.2)
Also applies to:
EN 301 549 Criteria
e 9.2.1.4 (Web)
e 10.2.1.4 (Non-web document)
e 11.2.1.4.1 (Open Functionality Software)
e 11.2.1.4.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

Supports (N/A)

RefWorks does not use single letter keyboard commands to
activate functions.

2.2.1 Timing Adjustable (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.2.1(Web)
e 10.2.2.1 (Non-web document)
e 11.2.2.1 (Open Functionality Software)
e 11.2.2.1 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)

Supports (N/A)

RefWorks does not require timed responses. The session
timeout for the RefWorks website is 14 days.
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e 602.3 (Support Docs)

2.2.2 Pause, Stop, Hide (Level A) Partially Supports Evaluated products do not use blinking, scrolling, or auto-

Also applies to: updating content.
EN 301 549 Criteria

e 9.2.2.2 (Web)

Exceptions:
e 10.2.2.2 (Non-web document) RefWorks:
e 11.2.2.2 (Open Functionality Software) e Tools > “How to Save to RefWorks” animation —
e 11.2.2.2 (Closed Software) Plays in a continuous loop and there are no controls
e 11.8.2 (Authoring Tool) to pause, stop, or hide it

e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 Conformance determined with manual visual checks.
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
2.3.1 Three Flashes or Below Threshold (Level A) Supports (N/A) RefWorks does not use flashing or blinking elements in the
Also applies to: user interface.
EN 301 549 Criteria
9.2.3.1 (Web)
10.2.3.1 (Non-web document)
11.2.3.1 (Open Functionality Software)
11.2.3.1 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

2.4.1 Bypass Blocks (Level A) Partially Supports Many pages have landmarks and heading structures that

Also applies to: allow users to bypass the global components and jump to
EN 301 549 Criteria

e 9.2.4.1(Web)

the main content.
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Criteria Conformance Level

10.2.4.1 (Non-web document) — Does not apply
11.2.4.1 (Open Functionality Software) — Does not apply
11.2.4.1 (Closed Software) — Does not apply
11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software) — Does not apply to non-web software
e 504.2 (Authoring Tool)
e 602.3 (Support Docs) — Does not apply to non-web docs
2.4.2 Page Titled (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.4.2 (Web)
e 10.2.4.2 (Non-web document)
e 11.2.4.2 (Open Functionality Software) - Does not apply
e 11.2.4.2 (Closed Software) — Does not apply
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

Partially Supports

2.4.3 Focus Order (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.4.3(Web)
e 10.2.4.3 (Non-web document)
e 11.2.4.3 (Open Functionality Software)

Partially Supports
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Remarks and Explanations

Exceptions:
e RCM
o Missing headings and landmarks

Conformance determined with manual keyboard checks.

Many evaluated product pages have descriptive and
informative page titles.

Exceptions:

e RCM
o <title> elements used on most pages do not
identify the contents or purpose of the
page
e Save to RefWorks
o Some pages are missing a page title. When
the page does have a title, it does not
identify the purpose of the screen

Conformance determined with Chrome developer tools and
manual visual checks.

The tab order through active elements follows the
sequences and relationships within the content.

Exceptions:
RefWorks



11.2.4.3 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)

e Focus is not returned to the triggering element
when the following modals are closed:
o Sharing Settings Modal
o Folders > Add folder modal
o Folders > Add subfolder modal
o Create bibliography > Differentiate authors
with the name by surname modal
Citation view > settings modal
o Create duplicate > Add more fields button
o RefWorks > Share a project modal
Remove button under "Owners"
e Focus is not trapped within modal for the following:
o Onboarding > Page 2
e Search results loading state — users can interact
with elements behind loading spinner overlay
e In Manage Projects focus order doesn’t follow
meaningful sequence:
o Share projects modal - Focus goes from
header, to input field, to close button
o Leave project modal - Focus goes from
header, Leave project button, to close
button, to cancel button
o Delete project modal - Focus goes from
header, Delete button, to close button, to
cancel button

o

Conformance determined with manual keyboard checks.

2.4.4 Link Purpose (In Context) (Level A)
Also applies to:
EN 301 549 Criteria

e 9.2.4.4(Web)

e 10.2.4.4 (Non-web document)

Partially Supports

Meaningful link text has been used throughout RefWorks.

Exceptions:
RefWorks
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11.2.4.4 (Open Functionality Software)
11.2.4.4 (Closed Software
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

e Tools > Extensions & Add-ons > Google Docs tab -
Not clear the button is to get add-on for Google
Docs

e Tools > Extensions & Add-ons > Hangul tab - Not
clear the button is to get add-on for Hangul

2.5.1 Pointer Gestures (Level A 2.1 and 2.2)
Also applies to:
EN 301 549 Criteria
e 9.2.5.1(Web)
e 10.2.5.1 (Non-web document)
e 11.2.5.1 (Open Functionality Software)
e 11.2.5.1 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

Supports (N/A)

No path-based or multi-point gestures are used in
RefWorks.

2.5.2 Pointer Cancellation (Level A 2.1 and 2.2)
Also applies to:
EN 301 549 Criteria
e 9.2.5.2 (Web)
e 10.2.5.2 (Non-web document)
e 11.2.5.2 (Open Functionality Software)
e 11.2.5.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

Supports (N/A)

No path-based or multi-point gestures are used in
RefWorks.
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Criteria Conformance Level Remarks and Explanations
2.5.3 Label in Name (Level A 2.1 and 2.2) Partially Supports User interface components that include a visible text label
Also applies to: have an accessible name that matches (or includes) the
EN 301 549 Criteria visible text in the label.
e 9.2.5.3(Web)
e 10.2.5.3 (Non-web document)

) } Exceptions:
* 11.2.5.3.1(Open Functionality Software) e “Close” modal label is missing or not clear for the
e 11.2.5.3.2 (Closed Software) following

e 11.8.2 (Authoring Tool)

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

o Add subfolders modal
o Onboarding popups

Conformance determined with Narrator, VoiceOver,
Chrome developer tools, and manual visual checks.

2.5.4 Motion Actuation (Level A 2.1 and 2.2) Supports (N/A) Evaluated products do not require motion controls or

Also applies to: physical gestures to access content or functionality.
EN 301 549 Criteria

e 9.254(Web)
e 10.2.5.4 (Non-web document)
e 11.2.5.4 (Open Functionality Software)
e 11.2.5.4 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508 — Does not apply

3.1.1 Language of Page (Level A)

Also applies to:

EN 301 549 Criteria
e 9.3.1.1(Web)
e 10.3.1.1 (Non-web document)
e 11.3.1.1.1 (Open Functionality Software)

Partially Supports For the RefWorks website and add-ons, the language

attribute is frequently missing or is always set to English,
regardless of the language of the page. The language
attribute for PDFs written in English is set correctly.

e 11.3.1.1.2 (Closed Software) Exceptions:
11.8.2 (Authoring Tool) e lang attribute missing from some content in
12.1.2 (Product Docs) RefWorks
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e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software) Conformance determined with Chrome developer tools,
e 504.2 (Authoring Tool) Adobe Acrobat Pro DC Accessibility Checker, and manual
e 602.3 (Support Docs) visual checks.

3.2.1 On Focus (Level A) Supports Context is not changed on focus alone.

Also applies to:
EN 301 549 Criteria
9.3.2.1 (Web)
10.3.2.1 (Non-web document)
11.3.2.1 (Open Functionality Software)
11.3.2.1 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)
3.2.2 On Input (Level A) Supports Entering data into, or changing the setting of, a user
Also applies to:
EN 301 549 Criteria

e 9.3.2.2(Web)

e 10.3.2.2 (Non-web document)

e 11.3.2.2 (Open Functionality Software) Context is not changes on user input in RefWorks
11.3.2.2 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

interface component does not trigger a change of context,
unless the user is given a warning ahead of time.
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Criteria
e 602.3 (Support Docs)

3.2.6 Consistent Help (Level A 2.2 only)
EN 301 549 Criteria — Does not apply
Revised Section 508 — Does not apply

3.3.1 Error Identification (Level A)
Also applies to:
EN 301 549 Criteria

e 9.3.3.1(Web)

e 10.3.3.1 (Non-web document)

e 11.3.3.1.1 (Open Functionality Software)

e 11.3.3.1.2 (Closed Software)

e 11.8.2 (Authoring Tool)

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)

Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)

3.3.2 Labels or Instructions (Level A)
Also applies to:
EN 301 549 Criteria

e 9.3.3.2 (Web)

e 10.3.3.2 (Non-web document)
11.3.3.2 (Open Functionality Software)
11.3.3.2 (Closed Software)
11.8.2 (Authoring Tool)

12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)

Conformance Level

Supports

Supports

Partially Supports
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Remarks and Explanations

Help links are located in the same, predictable location on
each page

Conformance determined with manual visual checks.

Forms provide text-based alerts for validation cues and
errors.

Invalid fields are visually marked. Generally, required fields
are marked. Errors describe the problem and inform the
user where the problem occurred.

Conformance determined with manual visual checks.

Input fields are clearly labelled, and instructions are
provided to assist the user when necessary. Required fields
are clearly marked and explained at the beginning of the
form.

Exceptions:
RefWorks is missing labels or instructions for:
e Screen readers
o Close button for
=  Add subfolder modal
= Rename folder modal



e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

o Search box for
= Side nav > tags

o Share folder > settings for > choose a folder
combobox

o Side nav > tags > search box clear button

Manage folders table header sort buttons

o Manage projects > Leave / Delete modal
buttons - Button just says "ok" instead of
describing destructive action

o

Conformance determined with WAVE and manual visual
checks.

Applies to:
WCAG 2.0 and 2.1 — Always answer ‘Supports’
WCAG 2.2 (obsolete and removed) - Does not apply
EN 301 549 Criteria

e 9.4.1.1(Web)
10.4.1.1 (Non-web document)
11.4.1.1.1 (Open Functionality Software)
11.4.1.1.2 (Closed Software) — Does not apply
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)

3.3.7 Redundant Entry (Level A 2.2 only) Supports Historical input is preserved
EN 301 549 Criteria — Does not apply
Revised Section 508 — Does not apply Conformance determined with manual visual checks.
4.1.1 Parsing (Level A) Supports For WCAG 2.0, 2.1, EN 301 549, and Revised 508 Standards,

the September 2023 errata update indicates this criterion is
always supported. See the WCAG 2.0 Editorial Errata and
the WCAG 2.1 Editorial Errata.
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4.1.2 Name, Role, Value (Level A) Partially Supports 'Pages conform to HTML web standards, so the name and

Also applies to: role of most Ul components can be determined.
EN 301 549 Criteria

e 9.4.1.2(Web)

e 10.4.1.2 (Non-web document) Exceptions:

e 11.4.1.2.1 (Open Functionality Software) RefWorks

e 11.4.1.2.2 (Closed Software) — Does not apply e Many form controls are missing a role and/or

e 11.8.2 (Authoring Tool) accessible name

e 12.1.2 (Product Docs) e Some custom elements, e.g. combo boxes, do not

e 12.2.4 (Support Docs) use valid ARIA role or attributes and are missing
Revised Section 508 accessible names

e 501 (Web)(Software) e Roles and attributes are sometimes not applied

e 504.2 (Authoring Tool) consistently to similar types of elements (e.g. menu

e 602.3 (Support Docs) items in the toolbar)

e Tab/tab panel roles and properties in Quick Cite,
Bulk edit, and Tools are missing

e Side bar navigation, citation style shortcut menus,
preview panel — Accordions elements appear and
functions like an accordion but is missing required
ARIA role(s) and states (expanded/collapsed)

Save to RefWorks

e iframe element does not have an accessible name

e |cons (Close, Navigation arrows) and input fields
(Tags, Abstract, and Notes) are missing an
accessible name

Conformance determined with Chrome developer tools and
manual visual checks.
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Table 2: Success Criteria, Level AA

Notes:
1.2.4 Captions (Live) (Level AA) Supports Captions are provided via YouTube

Also applies to:
EN 301 549 Criteria
9.1.2.4 (Web)
10.1.2.4 (Non-web document)
11.1.2.4 (Open Functionality Software)
11.1.2.4 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.2.5 Audio Description (Prerecorded) (Level AA) Supports Audio descriptions are provided via YouTube
Also applies to:
EN 301 549 Criteria
e 9.1.2.5(Web)
e 10.1.2.5 (Non-web document)
e 11.1.2.5(Open Functionality Software)
e 11.1.2.5(Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
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Criteria

1.3.4 Orientation (Level AA 2.1 and 2.2)
Also applies to:
EN 301 549 Criteria

9.1.3.4 (Web)

10.1.3.4 (Non-web document)
11.1.3.4 (Open Functionality Software)
11.1.3.4 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508 — Does not apply
1.3.5 Identify Input Purpose (Level AA 2.1 and 2.2)

Also applies to:
EN 301 549 Criteria

9.1.3.5 (Web)

10.1.3.5 (Non-web document)
11.1.3.5.1 (Open Functionality Software)
11.1.3.5.2 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508 — Does not apply
1.4.3 Contrast (Minimum) (Level AA)

Also applies to:
EN 301 549 Criteria

9.1.4.3 (Web)

10.1.4.3 (Non-web document)
11.1.4.3 (Open Functionality Software)
11.1.4.3 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508

Conformance Level
Partially Supports

Partially Supports

Partially Supports
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Remarks and Explanations

RefWorks has been developed with responsive web design
in mind. All web content and functionality is available
regardless of device orientation.

Exceptions:
RefWorks is partially responsive but not mobile-friendly

Conformance determined with manual visual checks.

When creating an account or logging into the website and
add-ons, some of the input fields can be programmatically
determined by the label.

Conformance determined with Chrome developer tools,
and manual visual checks.

Text throughout RefWorks meets the recommended
contrast ratio for text on background (4.5:1). In addition,
CSS style sheets can be switched off or overridden by user
preferences.

Exceptions:
RefWorks
e Low contrast on focus indicator for the button in
sharing settings modal > create a public URL > copy
URL button



e 501 (Web)(Software) e Preview pane > document language error - Low
e 504.2 (Authoring Tool) contrast of red text on red background
e 602.3 (Support Docs) e Low contrast for some focus states

e Some Ul elements fail the minimum contrast
requirement
e Tools > Extensions & Add-ons > Install Save to
RefWorks modal > Save to RefWorks button -
Low contrast of focus indicator
e Create duplicate > Find ref info lightning bolt
Lightning bolt icon before "Did you mean
one of these?" and close icons do not have
sufficient contrast
e Manage projects page > Create a new Project
button - Low contrast of focus indicator
e Manage projects page > Actions button - Low
contrast of focus indicator
e Manage projects page > Rename project modal
Close, cancel, and save buttons - Low
contrast of focus indicator
e Manage projects page > Leave project dialog
Close, and ok buttons - Low contrast of
focus indicator
e Manage projects page > Delete project dialog
Close, and ok buttons - Low contrast of
focus indicator

RCM

e All References
o Gray text on gray background (4.1:1)
o Gray and blue text on light blue hover and
focus states
e Login
o Red error text on light gray background
(4.2:1)
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o Gray text and blue links against a gray
background (4.1:1)
e Edit citation (with multiple references) > Reference
author and publication details
o Gray text on light gray background (4.1:1)
e (Citation style
o Format for footnotes — Gray text on white
background (2.8:1)
o Institutional style
= Green text on white background
(3.1:1)
= Green text on light blue
focus/hover (2.7:1)
e Toast messages
o White text on the red background (4.1:1)
o White text on green background (3.1:1)

Conformance determined with Deque’s Color Contrast
Analyzer and High Contrast Chrome extension.

1.4.4 Resize text (Level AA) Partially Supports Text throughout the Customer Knowledge Center, Save to
Also applies to: RefWorks, and RCM can be resized without assistive
EN 301 549 Criteria technology up to 200% without loss of content or
e 9.1.4.4(Web) functionality
e 10.1.4.4 (Non-web document)
e 11.1.4.4.1 (Open Functionality Software) Exceptions:
e 11.1.4.4.2 (Closed Software) RefWorks
e 11.8.2 (Authoring Tool) e partially supports resize text up to 200% however it
e 12.1.2 (Product Docs) is difficult to scroll the list of references in this
e 12.2.4 (Support Docs) viewport.
Revised Section 508
e 501 (Web)(Software) RCM (Windows)

e 504.2 (Authoring Tool) e Edit Citation
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Criteria Conformance Level Remarks and Explanations

e 602.3 (Support Docs) o Replace pages placeholder text is clipped
o Include date, prefix, and suffix input fields
and/or labels are clipped
e Preview Citation — Selecting a reference brings up a
preview of the citation, which is clipped and blocks
access to the reference list.
o Workaround to add multiple references to a
citation:
1. Insert the citation of one reference
into the document
2. Inthe document, place your cursor
in the citation’s content control
3. In RCM, click on the Add
reference(s) link
e (Citation styles > Lengthy citation style names are

clipped

e Author disambiguation > Dropdown menu options
are clipped

e Change Project > Warning — Title and content are
clipped

e Page header and reference information are
truncated instead of flowing to the next line

Conformance determined with manual visual checks.

1.4.5 Images of Text (Level AA) Partially Supports HTML/CSS is used to represent visual presentation

Also applies to: whenever possible. Informational graphics with embedded
EN 301 549 Criteria

e 9.1.4.5(Web)

e 10.1.4.5 (Non-web document)
e 11.1.4.5.1 (Open Functionality Software) Exceptions:

e 11.1.4.5.2 (Closed Software) — Does not apply RefWorks: How to use Save to RefWorks animation
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)

text are accompanied by html text on the same page.

Conformance determined with manual visual checks.
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Criteria
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.4.10 Reflow (Level AA 2.1 and 2.2)
Also applies to:
EN 301 549 Criteria
e 9.1.4.10 (Web)
e 10.1.4.10 (Non-web document)
e 11.1.4.10 (Open Functionality Software)
e 11.1.4.10 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

1.4.11 Non-text Contrast (Level AA 2.1 and 2.2)
Also applies to:
EN 301 549 Criteria
e 9.1.4.11 (Web)
e 10.1.4.11 (Non-web document)
e 11.1.4.11 (Open Functionality Software)

Conformance Level

Partially Supports

Partially Supports
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Remarks and Explanations

The RefWorks interface has been designed and developed
to be viewed comfortably on a tablet. When the text and
columns reflow on browser resize or zoom, a horizontal
scrollbar appears on most pages.

Products vary on the amount of zoom they support when
the viewport is set to 1280 pixels wide:

RefWorks

e Only supports a zoom of 125% without losing access
to content or functionality

e At high magnifications, zoom will interfere with
access to content and features

e When the width of the browser window is narrower
than 980px, the tabular view of references makes
use of a horizontal scroll to see all the content

Save to RefWorks
e Only supports a zoom of 300% without losing access
to content or functionality

Conformance determined with Chrome developer tools and
manual visual checks.

Non-text content, such as icons, meets minimum standards
of 3:1 color contrast ratio with the surrounding background.

Exceptions:
RefWorks



e 11.1.4.11 (Closed Software) e Some disabled elements in RefWorks may not meet
e 11.8.2 (Authoring Tool) the non-text minimum contrast requirement.
e 12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508 — Does not apply * Navigation

o Bibliography switch (off state) — White icons
on gray background
o Gray arrow icon on light blue focus/hover
color (2.4:1)
o Gray close button on light blue focus/hover
color (2.4:1)
e (Citation style dropdown
o Orange star icon on white background
(2.2:1)
o Gray accordion color on white background
(1.1:1)
o Blue hover/focus accordion color on white
background (1.2:1)
e Preview citation — Light gray Cancel button border
on white background (2.2:1)
e Refresh icon — White icon on gray background
(2.5:1)
e Toast message — Light green Close icon on green
background (1.8:1)

Save to RefWorks

e Gray checkbox border on white background (1.8:1)
e Gray input box border on white background (1.4:1)

Conformance determined with Deque’s Color Contrast
Analyzer and Color Contrast Analyzer Chrome extension.
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Criteria

1.4.12 Text Spacing (Level AA 2.1 and 2.2)

Also applies to:
EN 301 549 Criteria

9.1.4.12 (Web)

10.1.4.12 (Non-web document)
11.1.4.12 (Open Functionality Software)
11.1.4.12 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508 — Does not apply

1.4.13 Content on Hover or Focus (Level AA 2.1 and 2.2)

Also applies to:
EN 301 549 Criteria

9.1.4.13 (Web)

10.1.4.13 (Non-web document)
11.1.4.13 (Open Functionality Software)
11.1.4.13 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508 — Does not apply
2.4.5 Multiple Ways (Level AA)

Also applies to:
EN 301 549 Criteria

9.2.4.5 (Web)

Conformance Level
Partially Supports

Partially Supports

Supports (N/A)

Remarks and Explanations

Most text on the site is styled without any fixed heights or
widths and most text in containers have containers that
grow with them and do not overlap other containers.

Exceptions:

e Save to RefWorks
o €SS cannot be modified

o RefWorks for Google Docs
o CSS cannot be modified

Conformance determined with Chrome developer tools and
manual visual checks.

Tooltips remain visible until user moves hover or focus.

Exceptions:
In RefWorks and RCM, tooltips cannot be dismissed on
escape key

Conformance determined with manual visual and keyboard
checks.

Not applicable to RefWorks website, Save to RefWorks,
RefWorks for Google Docs, and RCM.

e 10.2.4.5 (Non-web document) — Does not apply
e 11.2.4.5(Open Functionality Software) — Does not apply
e 11.2.4.5(Closed Software) — Does not apply
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Criteria Conformance Level Remarks and Explanations
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software) — Does not apply to non-web software
e 504.2 (Authoring Tool)
e 602.3 (Support Docs) — Does not apply to non-web docs
2.4.6 Headings and Labels (Level AA) Partially Supports Descriptive headings and labels have been used throughout

Also applies to: the site, its writing tool add-ons, and the customer
EN 301 549 Criteria

e 9.2.4.6 (Web)

knowledge center.

e 10.2.4.6 (Non-web document)

e 11.2.4.6 (Open Functionality Software) Exceptions:

e 11.2.4.6 (Closed Software) RefWorks:

e 11.8.2 (Authoring Tool) e There are some labels in RefWorks that do not

e 12.1.2 (Product Docs) accurately descriptive, such as “times” for the

e 12.2.4 (Support Docs) J’;;:;Zj"mb;c;cz?sn on the add subfolder and rename
Revised Section 508

e 501 (Web)(Software) e Tools > Extensions & Add-ons > Install Save to

e 504.2 (Authoring Tool) RefWorks modal - No header on modal

e 602.3 (Support Docs) e Manage Folder page > Header - Manage Folders in

h2 tag but should be in an h1 tag
e Tools > Extensions & Add-ons > Install Save to
RefWorks modal - Missing label for close button

Conformance determined with WAVE and manual visual
checks.

2.4.7 Focus Visible (Level AA) Partially Supports Interactive elements (e.g. link text, buttons, etc.) are styled
Also applies to:
EN 301 549 Criteria
e 9.24.7(Web)

to noticeably change in visual appearance on hover or focus
or use the browser’s default focus state.
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Criteria

10.2.4.7 (Non-web document)
11.2.4.7 (Open Functionality Software)
11.2.4.7 (Closed Software)
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)

Conformance Level Remarks and Explanations

Exceptions:
RefWorks

Reference list > dropdown menus — Once a menu
option is selected from an expanded dropdown,
there is no visual indication that active focus has
returned to the collapsed state of the same
dropdown component

Share modal — Permissions dropdown menu is
missing a hover and focus state

Project > Share Project — Hover and focus states for
the email input field are barely perceptible

Tools > Extensions & Add-ons > Install Save to
RefWorks modal -No visible focus state when modal
opened

Create duplicate > Between warning banner and
close button - Visible focus indicator is lost

Manage projects page > Share a project modal -
Invite others input box missing focus indicator
Manage projects page > Share a project modal -
Owners accordion missing focus indicator

RCM (Windows)
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Change Language, Project, Citation style, Author
disambiguation settings
o Cancel button — Missing focus state
o Update buttons — Missing focus state
Edit citation
o For citations that contains multiple
references, the focus state for the
accordion arrow is barely perceptible



o When focus shifts from the content control
in the Word document to the RCM pane,
focus on the RCM pane is barely perceptible

e Preview citation

o Preview citation — Focus state for footnote
and in-text citation radio buttons is barely
perceptible

o Reference list

o Once a menu option is selected from an
expanded dropdown, there is no visual
indicator that active focus has returned to
the collapsed state of the same dropdown

component
e Search
o Clear search ("X") button — Missing focus
state

o Visual focus is lost when you tab away from
an empty search field

Conformance determined with manual visual and keyboard
checks.

2.4.11 Focus Not Obscured (Minimum) (Level AA 2.2 only)
EN 301 549 Criteria — Does not apply
Revised Section 508 — Does not apply

Partially Supports

Most components that obscure content in RefWorks when
open, reveal hidden content when focus is moved away
from component or component is closed.

Exceptions:
There are some menu pop-ups in RefWorks that do not
close on Escape or Tab to and from the menu. Including:
e Side navigation > folder sort menu
e Side navigation > folder options menu

e Add areference menu
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e Import references from other file types > Import
from file > Import Options > Assign to folder
dropdown

e Direct Export > Import References > Assign to folder
dropdown

Conformance determined with manual visual and keyboard

checks.
2.5.7 Dragging Movements (Level AA 2.2 only) Partially Supports For drag and drop features in RefWorks single point
EN 301 549 Criteria — Does not apply alternatives are supported.
Revised Section 508 — Does not apply
Exceptions:
RefWorks

e Tools > Extensions & Add-ons - Install Save to
RefWorks modal > Save to RefWorks button
alternative option to add StR to favorites
bar missing

Conformance determined with keyboard and manual visual

checks.
2.5.8 Target Size (Minimum) (Level AA 2.2 only) Partially Supports Most interactive elements in RefWorks support the
EN 301 549 Criteria — Does not apply minimum target size requirements.
Revised Section 508 — Does not apply
Exceptions:
RefWorks:

e Accordion expand/collapse button for folders in the
side navigation

e Manage Folder page > Expand/collapse folders
button - Button target size currently 14px*14px

e Manage Folder page > Table header sort buttons -
Button target size currently 14px*14px
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Criteria Conformance Level

3.1.2 Language of Parts (Level AA)
Also applies to:
EN 301 549 Criteria

e 9.3.1.2 (Web)

e 10.3.1.2 (Non-web document)

e 11.3.1.2 (Open Functionality Software) — Does not apply

e 11.3.1.2 (Closed Software) — Does not apply

e 11.8.2 (Authoring Tool)

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)

Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)

3.2.3 Consistent Navigation (Level AA)
Also applies to:
EN 301 549 Criteria

e 9.3.2.3(Web)

e 10.3.2.3 (Non-web document) — Does not apply
11.3.2.3 (Open Functionality Software) — Does not apply
11.3.2.3 (Closed Software) — Does not apply
11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

e 12.2.4 (Support Docs)

Revised Section 508

e 501 (Web)(Software) — Does not apply to non-web software

e 504.2 (Authoring Tool)

e 602.3 (Support Docs) — Does not apply to non-web docs
3.2.4 Consistent Identification (Level AA)

Also applies to:
EN 301 549 Criteria

Does Not Support

Supports

Partially Supports
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Remarks and Explanations

Conformance determined with Chrome developer tools,
and manual visual checks.

On the RefWorks website and add-ons, content related to
the interface is always displayed in the primary language.
The website and add-ons are not coded to identify changes
to language in content created or imported by the user.
Support resources are not coded to identify changes in
language within a webpage.

Conformance determined with Chrome developer tools and
manual visual checks.

The global header links and secondary navigation appear in
the same place and in the same relative order on every
page in the site. Pagination within a set of pages is
consistent.

Conformance determined with manual visual checks.

Care has been taken to identify components with the same
functionality consistently throughout RefWorks and the
writing tool add-ons.



Criteria

9.3.2.4 (Web)

11.3.2.4 (Closed Software) — Does not apply
11.8.2 (Authoring Tool)
12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software) — Does not apply to non-web software

e 504.2 (Authoring Tool)

e 602.3 (Support Docs) — Does not apply to non-web docs

3.3.3 Error Suggestion (Level AA)
Also applies to:
EN 301 549 Criteria

e 9.3.3.3(Web)

e 10.3.3.3 (Non-web document)
11.3.3.3 (Open Functionality Software)
11.3.3.3 (Closed Software)
11.8.2 (Authoring Tool)

12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

3.3.4 Error Prevention (Legal, Financial, Data) (Level AA)
Also applies to:
EN 301 549 Criteria

10.3.2.4 (Non-web document) — Does not apply
11.3.2.4 (Open Functionality Software) — Does not apply

Conformance Level

Partially Supports

Supports
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Remarks and Explanations

Exceptions:
RefWorks
e Reference actions toolbar > Create Bibliography
label is used as a category and an option
o Reference Editor > Text alternatives for the Edit
icon are not consistent across views (e.g. Edit the
selected document, Edit this reference)

Conformance determined with Narrator, VoiceOver and
manual visual checks.

Suggestions for error correction are made when applicable.

Exceptions:
RefWorks
e Login > Email field — Error message does not suggest
entering a valid email address format
e (Create account > Select your institution — Missing
error and error suggestion
e Create/Edit reference > Language field — Missing
examples of valid language codes

RCM
e Login > Email field — Error message does not suggest
entering a valid email address format

Conformance determined with manual visual checks.

When a user action can cause unrecoverable changes to
user data, the changes/deletions must be confirmed by the
user.



Criteria

9.3.3.4 (Web)

10.3.3.4 (Non-web document)
11.3.3.4 (Open Functionality Software)
11.3.3.4 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508

3.3.8 Accessible Authentication (Minimum) (Level AA 2.2 only)

501 (Web)(Software)
504.2 (Authoring Tool)
602.3 (Support Docs)

EN 301 549 Criteria — Does not apply
Revised Section 508 — Does not apply

4.1.3 Status Messages (Level AA 2.1 and 2.2)

Also applies to:
EN 301 549 Criteria

9.4.1.3 (Web)

10.4.1.3 (Non-web document)

11.4.1.3 (Open Functionality Software)
11.4.1.3 (Closed Software) — Does not apply
11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508 — Does not apply

Conformance Level

Supports

Partially Supports
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Remarks and Explanations

Conformance determined with manual visual checks.

Users can copy and paste their username and passwords
into the respective fields on the login page or use their
browser password manager.

Conformance determined with manual visual checks.

New features are developed with live status messages in
RefWorks, RCM, and Save to RefWorks.

Exceptions:
RefWorks:
e Older messages in RefWorks may be missing live
status announcements
e Manage folders Expand/collapse buttons - Does not
announce to user when button expanded or
collapsed
e Manage folders Table header sort buttons - Does
not announce to user when button expanded or
collapsed
e Create duplicate > Find ref info lightning bolt -
Missing message about lightning bolt overlay being
opened



e Manage projects Table header sort buttons - Does
not announce to user when button expanded or
collapsed

e Manage projects > Set as current project success
message - Not read to screen readers

e Manage projects > Leave project modal success /
error messages - Not read to screen readers

e Manage projects > Delete project success message -
Not read to screen readers

o RefWorks > Share project modal success
message - Not read to screen readers

Conformance determined with Narrator, VoiceOver and
manual visual checks.
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Revised Section 508 Report

Notes:

Chapter 3: Functional Performance Criteria (FPC)

Notes:

302.1 Without Vision Partially Supports This product is coded to work with screen
readers and other assistive technologies.

Exceptions:

See sections 1.1.1,1.3.1,2.1.1,2.1.2,2.4.1,
2.4.2,243,2.4.4,2.4.6,2.5.7,3.1.1,3.2.4,
3.3.1,3.3.3,4.1.2, and 4.1.3 for exceptions

Conformance determined with Narrator,
VoiceOver, Deque’s axe DevTools accessibility
testing tool, Chrome Developer Tools and
manual visual and keyboard checks.

302.2 With Limited Vision Partially Supports This product is coded to work with screen
readers and other assistive technologies. In
addition, text size and color contrast can be
adjusted through platform and browser
functionality.

Exceptions:

See sections 1.1.1,1.3.1,1.3.4,1.4.1,1.4.3,
1.4.4,1.4.5,1.4.10,1.4.11,1.4.12,1.4.13,
2.1.2,2.4.1,2.4.2,2.43,2.4.4,2.4.6,2.4.7,
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2.5.7,3.1.1,3.2.4,3.3.2,3.3.3,4.1.2and 4.1.3
for exceptions

Conformance determined with Narrator,
VoiceOver, Deque’s Color Contrast Analyzer,
Deque’s axe DevTools accessibility testing
tool, High Contrast Chrome extension,
Chrome Developer Tools and manual visual
and keyboard checks.

302.3 Without Perception of Color Partially Supports Color is used to enhance usability by drawing
attention to certain areas of the screen. Color
is never the only means of conveying
information, indicating an action, prompting
a response, or distinguishing a visual
element. If needed, the product’s CSS can be
overridden using the browser.

Exceptions:
See sections: 1.4.1 for exceptions

Conformance determined with High Contrast
Chrome extension and manual visual.

302.4 Without Hearing Partially Supports User hearing is not required to search,
browse, or use features that are available in
the evaluated products.

Exceptions:
See sections: 1.1.1 and 3.1.1 for exceptions

Conformance determined with Narrator,
VoiceOver, and manual checks
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302.5 With Limited Hearing Partially Supports User hearing is not required to search,
browse, or use features that are available in
the evaluated products.

Exceptions:
See sections: 1.1.1 and 3.1.1 for exceptions

Conformance determined with Narrator,
VoiceOver, and manual checks

302.6 Without Speech Supports (N/A) No WCAG 2.0 criteria apply

302.7 With Limited Manipulation Partially Supports Screen elements are designed to be
accessible to users without fine motor control
(e.g., most clickable areas are suitably sized
and spaced). Links and form elements can be
accessed using the tab key.

Exceptions:

See sections: 1.3.5,2.1.1,2.1.2,2.4.1,2.4.2,
243,246,2.4.7,2.5.3,2.5.7,3.2.4,3.3.3,
and 4.1.2 for exceptions

Conformance determined with Narrator,
VoiceOver, Deque’s Color Contrast Analyzer,
Deque’s axe DevTools accessibility testing
tool, High Contrast Chrome extension,
Chrome Developer Tools and manual visual
and keyboard checks.

302.8 With Limited Reach and Strength Supports (N/A) No WCAG 2.0 criteria apply

302.9 With Limited Language, Cognitive, and Learning Abilities Partially Supports The product provides features that make its
use by individuals with limited cognitive,
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language, and learning abilities simpler and
easier.

Exceptions:

See sections: 1.1.1, 1.2.5,1.3.1,1.3.2, 1.3.3,
1.3.5,1.4.1,1.45,1.4.12,1.4.13,2.1.1,2.4.1,
2.4.2,2.4.3,2.4.6,2.4.7,3.1.1,3.2.2,3.2.4,
3.3.1,3.3.2,3.3.3,4.1.2, and 4.1.3 for
exceptions

Conformance determined with Narrator,
VoiceOver, Deque’s Color Contrast Analyzer,
Deque’s axe DevTools accessibility testing
tool, High Contrast Chrome extension,
Chrome Developer Tools and manual visual
and keyboard checks.

Chapter 5: Software

Notes: Product does not contain non-Web software. See WCAG 2.X section for WCAG 2.0 Level A and AA success criteria conformance details for Web applications.

Chapter 6: Support Documentation and Services

Notes:

Criteria ~~ ConformanceLevel =~ Remarks and Explanations

601.1 Scope Heading cell — no response required Heading cell — no response required

602 Support Documentation Heading cell — no response required Heading cell — no response required

602.2 Accessibility and Compatibility Features Supports The RefWorks Customer Knowledge Center
provides a link to the RefWorks accessibility
compliance statement and some
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documentation on how to use the
accessibility and compatibility features
required by Chapters 4 and 5.

602.3 Electronic Support Documentation See WCAG 2.X section See information in WCAG 2.X section

602.4 Alternate Formats for Non-Electronic Support Documentation Supports Product support documentation is provided
online through the RefWorks Customer
Knowledge Center. This documentation can
be accessed online or printed. End-users can
also contact customer support (by phone,
email, chat, or web form) to request any
further help.

603 Support Services Heading cell — no response required Heading cell — no response required

603.2 Information on Accessibility and Compatibility Features Supports The RefWorks Customer Knowledge Center
provides a link to the RefWorks accessibility
compliance statement and documentation on
how to use the accessibility and compatibility
features required by Chapters 4 and 5.

603.3 Accommodation of Communication Needs Supports Support services are available to
accommodate the communication needs of
end users with disabilities.

Users can communicate with customer

support via:
e Phone
e Email
e Chat
e Web form
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EN 301 549 Report

Notes:

Chapter 4: Functional Performance Statements (FPS)

Notes:

4.2.1 Usage without vision Partially Supports This product is coded to work with screen
readers and other assistive technologies.

Exceptions:

See sections 1.1.1,1.3.1,2.1.1,2.1.2,2.4.1,
2.4.2,2.43,2.4.4,2.4.6,2.5.7,3.1.1, 3.2.4,
3.3.1,3.3.3,4.1.2, and 4.1.3 for exceptions

Conformance determined with Narrator,
VoiceOver, Deque’s axe DevTools accessibility
testing tool, Chrome Developer Tools and
manual visual and keyboard checks.

4.2.2 Usage with limited vision Partially Supports This product is coded to work with screen
readers and other assistive technologies. In
addition, text size and color contrast can be
adjusted through platform and browser
functionality.

Exceptions:

See sections 1.1.1,1.3.1,1.3.4,1.4.1,1.4.3,
1.4.4,1.4.5,1.4.10,1.4.11,1.4.12,1.4.13,
2.1.2,2.4.1,2.4.2,2.43,2.4.4,2.4.6,2.4.7,
2.5.7,3.1.1,3.2.4,3.3.2,3.3.3,4.1.2and 4.1.3
for exceptions
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Conformance determined with Narrator,
VoiceOver, Deque’s Color Contrast Analyzer,
Deque’s axe DevTools accessibility testing
tool, High Contrast Chrome extension,
Chrome Developer Tools and manual visual
and keyboard checks.

4.2.3 Usage without perception of colour Partially Supports Color is used to enhance usability by drawing

attention to certain areas of the screen. Color
is never the only means of conveying
information, indicating an action, prompting
a response, or distinguishing a visual
element. If needed, the product’s CSS can be
overridden using the browser.

Exceptions:
See sections: 1.4.1 for exceptions

Conformance determined with High Contrast
Chrome extension and manual visual.

4.2.4 Usage without hearing Partially Supports User hearing is not required to search,
browse, or use features that are available in
the evaluated products.

Exceptions:
See sections: 1.1.1 and 3.1.1 for exceptions

Conformance determined with Narrator,
VoiceOver, and manual checks
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4.2.5 Usage with limited hearing Partially Supports User hearing is not required to search,
browse, or use features that are available in
the evaluated products.

Exceptions:
See sections: 1.1.1 and 3.1.1 for exceptions

Conformance determined with Narrator,
VoiceOver, and manual checks

4.2.6 Usage with no or limited vocal capability Supports Our platforms do not require users to
generate vocal input.
4.2.7 Usage with limited manipulation or strength Partially Supports Screen elements are designed to be

accessible to users without fine motor
control (e.g., most clickable areas are suitably
sized and spaced). Links and form elements
can be accessed using the tab key.

Exceptions:

See sections: 1.3.5,2.1.1,2.1.2,2.4.1,2.4.2,
243,246,2.4.7,2.53,2.5.7,3.2.4,3.3.3,
and 4.1.2 for exceptions

Conformance determined with Narrator,
VoiceOver, Deque’s Color Contrast Analyzer,
Deque’s axe DevTools accessibility testing
tool, High Contrast Chrome extension,
Chrome Developer Tools and manual visual
and keyboard checks.

4.2.8 Usage with limited reach Supports No WCAG 2.0 criteria apply
4.2.9 Minimize photosensitive seizure triggers Supports Our platforms do not include flashing
content.
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4.2.10 Usage with limited cognition, language or learning Partially Supports The product provides features that make its
use by individuals with limited cognitive,
language, and learning abilities simpler and
easier.

Exceptions:

See sections: 1.1.1, 1.2.5, 1.3.1, 1.3.2, 1.3.3,
1.35,1.4.1,1.45,1.4.12,1.4.13,2.1.1,2.4.1,
2.4.2,2.43,2.46,2.4.7,3.1.1,3.2.2,3.2.4,
3.3.1,3.3.2,3.3.3,4.1.2, and 4.1.3 for
exceptions

Conformance determined with Narrator,
VoiceOver, Deque’s Color Contrast Analyzer,
Deque’s axe DevTools accessibility testing
tool, High Contrast Chrome extension,
Chrome Developer Tools and manual visual
and keyboard checks.

4.2.11 Privacy Supports Privacy settings are made available to users in
an accessible way.

Chapter 9: Web

Chapter 12: Documentation and Support Services
Critertld ~~ Conformancelevel ~  RemarksandExplanations

12.1 Product documentation Heading cell — no response required Heading cell — no response required

12.1.1 Accessibility and compatibility features Supports The RefWorks Customer Knowledge Center
provides a link to the RefWorks accessibility
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Criteria

12.1.2 Accessible documentation
12.2 Support Services
12.2.2 Information on accessibility and compatibility features

12.2.3 Effective communication

12.2.4 Accessible documentation

Legal Disclaimer (Clarivate)

Conformance Level

See WCAG 2.X section
Heading cell — no response required
Supports

Supports

See WCAG 2.X section

Remarks and Explanations

compliance statement and some
documentation on how to use the
accessibility and compatibility features
required.

See information in WCAG 2.X section
Heading cell — no response required

The RefWorks Customer Knowledge Center
provides a link to the RefWorks accessibility
compliance statement and documentation on
how to use the accessibility and compatibility
features required.

Support services are available to
accommodate the communication needs of
end users with disabilities.

Users can communicate with customer

support via:
e Phone
e Email
e Chat
e Web form

See information in WCAG 2.X section

This Accessibility Conformance Report represents the specific release of the product described, as of the date of this document. Notwithstanding the information contained
in the Accessibility Conformance Report, if use of the product is subject to a license agreement, the terms and conditions of the product’s license agreement remain in full
force and effect, including any limitation of liability and disclaimer of warranties provisions.
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